
About the SQL integrated environment

1. SQL editor with syntax highlighting, multilevel Undo/Redo features and integrated searching
and replacement tools. You can use macros to automate entering frequently used fragments. 
Lets you work with scripts more effectively 

2. Supports ODBC, IDAPI and OCI data source connection with detailed database information.
Provides the quick view of the database schema and results of the query execution. 

3. Easy access to the file history and the history of the scripts already executed. You can 
quickly switch to the required file or the previously run script with just a single mouse 
click. 

4. A convenient way to display results of the script execution. The application supports clipboard
and data export tools. The program exports data to plain text, HTML page, XML document,
and Microsoft Excel spreadsheet. You can save query results as a set of SQL statements.

5. Step-by-step SQL builder (query builder) is the most intuitive and natural way to build 
complex SQL statements visually without submersing into SQL.
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Product versions

There are three versions of the DTM SQL editor: 

 Standard - this version is intended for individual users who usually work with a small 
number of SQL scripts and do not use multiple connections to various data sources. 

 Professional - this version suits professionals and small working groups that work 
simultaneously with several data sources both on database servers and in desktop 
formats and have higher requirements as long as working with database schemas is 
concerned. 

 Enterprise - the corporate edition without any limitations concerning the number of 
connections and edited scripts. Besides, this product supports a number of additional 
features and options.

Please refer the following table to explore differences between the product versions: 
Option Standard Professional Enterprise

Connections

Simultaneous connections 3 5 Unlimited

Schema

Schema Snapshots No Yes Yes

Schema Export No Yes Yes

Editor

Maximum text windows 5 10 Unlimited
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Technical information, System requirements

System requirements

DTM SQL editor is a true Win32 application, known to be compatible with the following
operating systems:

 Windows NT version 4.0 (Service Pack 3 and Internet Explorer 3 or higher required) 
 Windows 2000 family 
 Windows XP (Home and Professional) 
 Windows 2003 and 2008 Server family 
 Windows Vista
 Windows 7 or 8 (desktop) 

You'll need 32 -bit ODBC, IDAPI or OCI (Oracle Call Interface)  interface to run SQL scripts,
to view database schema or to employ the SQL-statement builder. 

Hardware requirements

 RAM: 64 MB when running under Windows 95, 98 or ME, 128 MB when running under 
Windows NT, 2000, XP, 7/8 or 2003/2008 Server 

 Hard Disk: minimum 3 MB of free space required for installation 
 Display: 800 x 600 or higher resolution, 256 colors 

Compatibility note

Considering the fact that there may be some misinterpretations of the unified DBMS 
interface specification, the problems may arise with some exotic ODBC or IDAPI drivers. For 
example, missing data types, garbled non-standard data type support etc. Please contact 
our technical support when problems of this nature arise. When you contact technical 
support, you should be prepared to provide the following information:

 DTM SQL editor version (you can find this information from About menu item of Help 
menu). 

 Type and version of the ODBC (or IDAPI) driver. 
 DBMS version and operating system version (including service pack version, if 

applicable). 
 DTM SQL editor Log file. 
 A description of what you do before the problem occurs. 
 Error messages you see when the problem occurs. 
 Your name, company name and how to contact you. 

Limitations

1. Maximum column width in the results view is 512 characters. 
2. Export of large binary objects does not supported. 
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User interface

The main program window consists of the next four panels: 

 Schema window at the upper-left corner  
 SQL editors window at the upper-right corner  
 Schema item information window at the left-lower corner  
 Execution results window 

You can set the size and placement of the main window at your will. You can also
maximize it to fill the entire screen. Use the default window button for that or select the
appropriate item in the system menu of the main window. (Use Alt-Space to access the 
system menu, or click the icon in the upper-left corner of the main window).  

Also, You can hide or show toolbar buttons using "View->Customize toolbars" menu item. 
You can place program toolbars at your will or hide any toolbar: 
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Hot keys

Hotkey Function or Option

 Ctrl+A  Select all text or data in grid

 Ctrl+B  Run SQL builder

 Ctrl+C or Ctrl+Ins  Copy selected text or item

 Ctrl+D  Disconnect current connection

 Ctrl+F  Search and replace

 Ctrl+E  Connect to data file

 Ctrl+G  Go to specified editor line

 Ctrl+L  Load file

 Ctrl+N  New editor window

 Ctrl+O  Connect to data source

 Ctrl+P  Print SQL script from current window

 Ctrl+Q  Exit program

 Ctrl+R  Execute current script

 Ctrl+S  Save current script

 Ctrl+V or Shift+Ins  Paste test

 F1  Show help file

 F3  Search Next

 Alt+F7  Product settings

 Ctrl+X  Export results

 Ctrl+<number>  Set text bookmark

 Ctrl+Shift+<number>  Go to bookmark

 Ctrl+Shift+<letter>  Insert text for macros
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Editor commands

You can load SQL scripts using one of the following methods:

 type the name of the file as the command line argument 
 direct file loading
 automatic file loading
 drag-n-drop the file into the main window of the editor  
 restore script from the backup copy (after software or hardware failure). 

You can perform clipboard operations either with mouse or keyboard or by selecting the 
items from the local menu that can be accessed by the right mouse button click inside the 
main window.

Moreover, you can search and replace any items. Undo/Redo functions are also 
implemented. You can press Ctrl-Z and Ctrl-Y without any worry to lose your work. 

There is a picture of local menu accessed by the right click inside the editor window. See 
the picture below:

Using this menu you can:

 perform clipboard operations. 
 do bulk text operations. 
 search/replace. 
 execute other additional operations. 

Using toolbar buttons You can:

 load and save files.
 start a new file in the new editor window.
 call search and replace dialog. 
 perform clipboard operations. 
 access to Redo/Undo features. 
 print script text. 
 call "macros" dialog. 
 comment and uncomment script line or selected fragment by the one click. 

Using Ctrl+G hotkey you can go to the required line of the current script. Besides product 
allows you to use bookmark: press Ctrl+<number key> to set bookmark for current cursor 
position and use Ctrl+Shift+<number key> for go to the stored bookmark. You can define 
up to 10 ('0' -'9') bookmarks. Bookmarks are script -specific and SQL editor does not save 
them between sessions.

To comment the current line out or to uncomment it, just press the button with two "minus 
sign" on it. To comment out a block, select it and press the button with a slash and an
asterisk on it. If you press this button when the cursor is in the commented area, it will be 
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uncommented.

Adding plug-ins to the DTM SQL editor helps users to extend the functionality of the editor 
tool  (PT_TEXT plug-in type). It is also a possibility for the third party developers wishing
to make additions to the program.

See also: "macros: definition and use", "search and replace"
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Search and replace tools

The "Search and Replace" feature helps you to find some text fragment and, if necessary, 
to replace this fragment with the new string you specify. Please use "Script->Search and 
Replace" menu item or corresponding toolbar button to access this option.

Use "Replace" button for this purpose. Press "Replace all" button to replace all strings 
found without the confirmation requests.

Please remember, pressing Ctrl-F will help you to access the search dialog faster. Employ 
the appropriate combo box to access the history.

"Search and replace" dialog saves the position of the window either for the current session 
or between sessions.
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Clipboard support, export features

Export results of Query Execution

Types of export:

 text file with separators or with fixed columns width. 
 HTML file 
 XML document 
 RTF document 
 set of SQL statements (INSERT or UPDATE) 
 direct to Microsoft® Excel (installed Microsoft Excel required) 

Warning! Export for long binary data types (also known as BLOBs) is not supported.

Clipboard support

 Copy selected text onto Clipboard Ctrl-Ins, Ctrl-C
 Cut selected onto Clipboard Shift-Del, Ctrl-X
 Insert text from clipboard into cursor position Shift-Ins, Ctrl-V
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SQL library

The SQL library is the perfect way to organize your SQL scripts. SQL library is a hierarchy of 
files and folders. You can add a script to the library using Windows explorer. You can also 
save the script from DTM SQL editor into SQL library.

To access SQL library click arrow near "Open" toolbar button and select "SQL library" item 
from the drop-down menu. 

The default location of the library is "library" subdirectory in the product folder. For 
example, "C:\Program Files\SQL editor\Library". You can change this value using settings 
dialog

The SQL script selected in the library can be saved using one of the following methods: 

 Insert - insert the file at the current cursor position.  
 Append - append the SQL file to the end of the script currently being edited.  
 Replace - replace the current script.  
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Results Viewer

If the SQL script being executed produces the resulting recordset(s) You can view it in the 
"Results" pane of the main window.

It allows You:

 to list the recordset one record by one or page by page (Up, Down, Page Up and Page 
Down buttons); 

 to seek begin or end of the recordset using Ctrl+PageUp and Ctrl+PageDown buttons. 
 to set the width of columns representing the fields of records; 
 to see the current record number and the total number of records in the status bar of 

the dialog;
 to place the cursor directly to the chosen record; 

Placing the mouse cursor over the column header will tell you the type of data stored in 
this field:

There is a picture of local menu accessed by the right click inside the results window.

Using this menu you can:

 copy selected items onto the clipboard 
 call "export dialog" 
 run "results" plug-ins, if present  

Using toolbar buttons you can:

 refresh data in the grid 
 select all present data in the grid
 copy selected data
 call "export dialog" for selected type of the export 
 sort results by the selected column (field) 
 print results 

"Results" window contains few result sets when you execute more than one SQL statement 
or statement (same as procedure call) returns multiple result sets. You can switch between 
result sets by click on the corresponding tab:
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Macro definition and using

Our software allows the user to create and use macros to speed up typing of frequently 
used SQL constructs. Macros are just text strings, either predefined or custom-made, 
representing the SQL construct. Pressing the hotkey, while in the editor window, will insert 
the associated macro at the current cursor position.

There are two kinds of macros - predefined, which you cannot change, and flexible user-
defined macros.

Use "Script->Macro definitions" menu item or corresponding toolbar button to create or 
edit the user-defined macros and then edit the needed lines in the dialog. Click "Save" 
button to save your changes or "Cancel" to abort them.
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Database schema viewer

Our software allows the user to view lists of

 tables with indexes, primary and foreign keys 
 access rights for tables and columns 
 system tables
 views or queries 
 synonyms 
 users (for MS SQL, Sybase, and Oracle data sources) 
 databases (for MS SQL Server 6.5 and higher data sources) 
 stored procedures 
 extended stored procedures (for MS SQL Server) 
 triggers (Microsoft SQL Server, Sybase, Oracle, and Interbase) 
 data types
 defaults (for Microsoft SQL and Sybase Server) 
 rules (for some data sources) 
 roles and server roles (for Microsoft SQL Server) 
 type (insert, update, etc) and status (enabled or disabled) of the triggers (MS SQL 

Server and Oracle) 

The program has some settings and options for the schema tree. The most important 
settings are types of the objects.

The Schema->Find schema object menu item helps you to find any object in the database. 

There is a picture of local menu accessed by the right click inside the schema tree window.

Local menu (and toolbar buttons) provides:

 copy object name and text (source of stored procedure, for example) 
 save object's test to external SQL file 

The software product enables the user to export schema of the current database as a set 
of SQL statements. You can use the corresponding toolbar button or "Export schema" item 
in Schema menu of the DTM SQL editor.

The snapshot mechanism allows saving of the current state of the database schema to a 
separate file that can be opened and viewed anytime later.

Adding plug-ins to the DTM SQL editor helps users to extend the functionality of the 
"Schema" tab local menu (PT_SCHEMA plug-in type). It is also a possibility for the third
party developers wishing to make additions to the program.
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Database object search feature

The "Find schema object" feature helps you to find any object in the database. You may 
use following search criteria or combination thereof:

 object name or part of the name 
 a database that contains the object (only for MS SQL and SYBASE databases) 
 object type same as TABLE, VIEW, PROCEDURE etc 
 text fragment of object definition (text of the stored procedure for example) 

Press F3 to run next search with current criteria.

Warning! Searching through the object text can considerably slow down the performance 
because the program extracts all texts of all the scanned objects from the database.

"Search" dialog saves the position of the window and entered data either for the current 
session or between sessions.
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Data editor

Data editor allows you enter or edit data for the single record. 
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Schema object additional information

You can see the additional database object information window at the left-lower corner of 
the main program window:

This window allows you to view object text and properties, to view data from the tables or 
views, to view access rights for tables, views and columns (if your driver and DBMS support 
it) and to perform some usual operations same as object dropping or renaming. Please 
switch to the "Properties" tab for view the properties of the object: 

You can view the object access rights using the "Permissions" tab: 

If you want to rename or drop database object, use "Operations" tab: 
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Schema filters usage

The program allows you to set filters for the database objects displayed in a tree-like
manner. Filters can have the same parameters as the search.

Be careful with filters, you can set such a filter that there won't be any objects displayed. 
Should this happen, exit the program and restart it - the product does not save filters upon 
exiting.

Note: the filter is not applying to collections (node items) and databases (Microsoft SQL
Server only).
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Version control

The program supports basic level of the integration with MS Visual Source Safe. You can:

 Check out module from VSS 
 Undo Check out module 
 Check in module to VSS 
 Add new item to VSS project 
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Command line options

DTM SQL editor supports following command line switch:

-r - if present, run current SQL script at program startup 
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Database Connection

Quick Start: how to connect?

There are five ways to connect to a database:

1. Direct connection 
2. Connection to desktop files 
3. Data source with ODBC, IDAPI or Oracle Call Interface (OCI) 
4. DSN File connection 
5. OLE DB connection 

In all modes the "Test" and "Information" buttons, as well as tools for working with
connection profiles are available. "Test" button allows you to check information you entered 
and/or data source (or alias) configuration. 

See also:

 Troubleshooting guide 
 Connection information 
 Connection profiles 
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Connection Quick Start Guide

Database How to connect

MS SQL Server Enter or select server name at the direct connection panel

Local SQL Server 
Express

Enter .\SQLEXPRESS as server name at the direct connection 
panel

Oracle
1) Switch to data sources mode
2) select OCI as "Interface"
3) select your service name from data source drop-down menu

DB2 Use direct connection panel or 
Use predefined ODBC DSN for custom connection settings

MySQL
Install ODBC driver for MySQL from www.mysql.org
Use direct connection panel or
Use predefined ODBC DSN for custom connection settings

PostgreSQL Use direct connection panel or 
Use predefined ODBC DSN for custom connection settings

Interbase/Firebird
Install ODBC driver
Use direct connection panel or
Use predefined ODBC DSN for custom connection settings

Microsoft Access 1) Switch to "Desktop File" panel
2) Select "Access" as file type, enter or select file name

Microsoft Excel 1) Switch to "Desktop File" panel
2) Select "Excel" as file type, enter or select file name

Another database

1) Install ODBC driver for your database system
2) Create ODBC data source name using Windows ODBC 
Administrator
3) Switch to data sources mode
4) select your data source from drop down menu
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Direct Database Connection

Direct Connection

The direct connection method allows you to connect to most popular databases (MS SQL 
Server, Oracle, Interbase/Firebird, MySQL, PostgreSQL and DB2). 
Enter the server name and the database name, if required. The user name and password
are optional. Their necessity depends on the settings of your database. The owner name
(schema) is optional too. The list of visible database objects depends on the choice of the
owner. If the owner is empty, you will access all objects. There is important that
schema/owner name is case sensitive. 
If you do not find the required database type in the list or cannot connect directly, use a
connection through the predefined data source. If DBMS is in the list, but unavailable, it
means that either the required ODBC driver is not installed or it is not configured properly.  
During its use, the program stores the entered values of server names, users and owners.
You can select a value from the stored list using the corresponding combo box. For some
DBMS types (MS SQL, for example), the program can fill the list of available databases.
Use the button with two arrows for this purpose. 

DBMS-specific connection options 

Microsoft SQL Server

 "(local)", empty or "." server name means local server 
 use <server name>\<instance name> syntax to identify instance. Example: 

.\SQLEXPRESS means SQL Express at the local system 

Oracle

Use connect string for the Oracle Server that you want to access as a Server name.

Important: it is strongly recommended to use native Oracle Call Interface (OCI) instead of
direct connection.

Interbase and Firebird

Examples: 

 Server: localhost and Database c:\interbase\myDb.fdb - connect to specified DB on 
local system.

 Server: 172.17.2.10/3051 and Database /usr/local/db/myDb.fdb - connect to 
specified server with alternate port 3051 on remote system 172.17.2.10 

MySQL
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 Use localhost for local MySQL 
 example.com;port=3306 means MySQL at example.com on 3306 port 

DB2

ServerName;port=5000;protocol=TCPIP as a server name means connect to 
ServerName, use 5000 port and TCP/IP protocol. 

PostgreSQL

ServerName as a server name means connect to ServerName, use 5432 port and TCP/IP 
protocol. Database name is required. localhost as a server name is acceptable. To specify 
custom port you should add ";port=NNNN" string to server name.
server_name_or_ip-address;port=5432;DATABASE=dbname 
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Desktop File Connection

Desktop Files

The second way is designed for connecting to desktop data files. Select the required format 
and specify the file name or the directory where the data is located. Other parameters are
optional. 
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Data Sources

Predefined data sources: ODBC, IDAPI, Oracle Call Interface

A connection with the use of a data source is the most universal. You can select ODBC,
IDAPI or OCI (if installed) interface and the preconfigured data source name. In this case,
other options are similar to those of a direct connection. The "Manage" button allows you
to get access to the external configuration utility if it is available. When you want to
access the tables belonging to the single database schema (or owner), you should fill the
"owner" entry; otherwise, all tables will be accessed. 
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File Data Source Name

DSN File

The fourth way is using a DSN file. For this case, just select the file name with DSN
definition. 
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OLE DB Connection

OLE DB connection

Use 'Configure' button to specify connection information. Password and owner fields are
optional. 
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Connection Profiles

Connection profile helps you to save information about your connection (interface, data
source or alias name, user name (login), password and database name, etc) and get access 
it by the one click. 

Please fill connection properties and press "Add as new" to add a new profile. To modify 
the profile you should select it from the list at the top of the window, modify properties
and press "Update". "Delete" button works when you select the profile to be deleted in the 
list.

"Save" and "Load" buttons allow you to save profiles to the disk file or load them. The 
"Export one" button helps to save single currently selected profile.

Important: all profiles are shared between all installed DTM soft products. That means 
once created profile can be used with any tool. At the other side if you remove the profile 
from the list you can't use it with DTM soft's products anymore.
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Connection Information

The program provides detailed database, connection and driver information and properties. 
The "Information" button at the connect window allows you to view it. 
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Database Connection Troubleshooting Guide

Troubleshooting Guide

Problem description Possible reason Solutions

Required database type not 
present in the list at Direct
Connection and Desktop 
Connection pages

 

Switch to "data source" 
connection mode and select data 
source from the list or configure 
new one with "Manage" button.

Required format is in the 
direct connection list, but not
available (disabled).

ODBC driver for your 
database does not
installed or not
configured properly.

Install required driver. If it is 
already present in the system, 
please contact our support staff.

Errors during direct 
connection. Compatibility problems. Try to create data source for 

your database connection.

Login error for correct user 
name and password.

Read-only desktop data 
file.

Try to change file mode to 'read 
and write'.

I can't see relationships, 
defaults, etc in my Access 
Database.

Access interface.

Try to switch on "Use Microsoft 
Jet" check box at the "Desktop 
File" page of the Connect 
Window.
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Program Settings

The program has some settings and options to make your work more comfortable. There 
are four group of the program settings:

1. General settings 
2. Editor settings 
3. Database Schema settings 
4. SQL Syntax settings 

Don't forget to press "Save" button in "Settings" dialog to save the settings you chose.

It is recommended to reload the program after settings changes.
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General Settings

Most important general settings are:

1. Should the program save main window position between sessions or no 
2. Should the program save database connections between sessions or no 
3. "Disable SQL parsing" option allows you to deal with the complex language constructs 

and non-standard SQL extensions. In some cases, the program cannot parse script 
correctly and then this option is necessary. 

4. Preview binary large objects (BLOBs) as text (in hexadecimal mode by default). 
5. "View NULLS as <NULL>" option allows selecting of the visualization mode for NULL 

values between displaying the special sign <NULL> and just emptying the cell. 
6. Should the program execute selected part of the text if present. The whole script will 

be executed otherwise 
7. Should the program remove comments before pass script to execution or no 
8. Export SQL statement separator like ';' or 'go' 
9. SQL Library location
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Editor Settings

Most important editor settings are:

1. Autosaving the file you are editing. Set this option to make the program save the file 
currently being edited at specified time intervals. It could help you to restore data in 
case of accidental crash (power failure, for example.) The auto-save interval is 3
minutes by default, but you may change it at your will. 

2. Size and the font face for SQL editor window 
3. "Tab" sign size (number of spaces) 
4. Should the program show special spaces, tabs, and symbols or no 
5. Autoindent mode on or off 
6. Should the program create backup (.BAK) file before new version saving 
7. Enable or disable IntelliSense feature
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Schema Settings

Most important database schema settings are types of database objects that the software
should show in the schema tree
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SQL Syntax Settings

Most important syntax highlighting settings are:

1. Turn the syntax highlighting for keywords, comments and strings (constants) on and 
off.

2. Colors for: keywords, comments, and constants 
3. Keywords list 
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Internal step-by-step SQL builder, query builder 

User of DTM SQL editor can take advantage of automating the creation of the most used 
SQL-statements such as: 

 SELECT 
 UPDATE 
 INSERT 
 DELETE 
 DROP TABLE 
 DROP VIEW 
 DROP INDEX 
 DROP PROCEDURE 
 CREATE TABLE 
 CREATE INDEX 
 CREATE VIEW 

First, the user should select the data source connection he or she wants to build the query 
for using "Schema tree".

The SQL statement created can be saved using one of the following methods:

 Insert - insert the result at the current cursor position  
 Append - append the result to the end of the script currently being edited  
 Replace - replace the current script  

See also:Statements
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SQL builder, type of the statement selection

At the first stage of the building process, you will have to specify the type of statement to
be constructed. Just select the required type. The default is SELECT.

See also: Select tables and views and Select one object 
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SQL builder, specify objects for SELECT statement

For a SELECT statement, you have to specify the list of what will be selected. It can be
objects of three types: fields of the tables and views marked by the user, aggregate 
functions, and arbitrary constructions entered manually.

To specify what field the function is applied to, mark the field or a group of fields in the
list, then select the function that will be used and press the button opposite the group of
functions with an arrow on it.

Use the DISTINCT button in case you have to select only unique values for the marked 
field. You can also specify aliases for columns of the results. To set or clear them, use the
AS button and the edit box next to it.

See also:Where clause and Order by and group by
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SQL builder. Build WHERE clause

You can specify an arbitrary number of comparisons in a WHERE clause.

They will be linked to each other by either OR or AND operators.

A HAVING statement is constructed much as a WHERE one.
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SQL builder, select tables or views

Mark the required tables and views in the list. If you want to set or clear the alias for a
table or a view, mark it in the list and use the "Alias" button with the corresponding edit 
box.

See also: Select columns and Items for SELECT statement.
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SQL builder, select one table or view

For some SQL statements you have to select only one table or view. Just mark the required 
object in the list and go over to the next step in constructing.
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SQL builder, select fields

To select several fields, mark them in the list one after another.

See also:Specify values 
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SQL builder, set or change columns values

To set or change the value, place the mouse cursor over the required field and start 
entering.
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SQL builder, ORDER BY and GROUP BY

The user allowed to specify the order of sorting and grouping the resulting data set. Select 
the required fields and move them into the ORDER BY or GROUP BY list depending on the 
situation.

See also:Where clause 
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SQL builder, create tables

To create a table, name it and enter the descriptions for its fields. For each field, except
type and size, you can specify its nullable property and whether this field is a part of 
primary key (PK).
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SQL builder, create indexes

To create an index, specify its name and main properties.

 "Unique" property means no two rows are permitted to have the same index value. 
 "Clustered" creates an object where the physical order of rows is the same as the 

indexed order of the rows. A object is allowed only one clustered index at a time. 
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SQL builder, create view

To create a view, specify its name and enter or copy the SELECT statement that will 
correspond to this view.
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Plug-ins and SDK

Adding plug-ins to the current version of DTM SQL editor helps users to extend the 
functionality of the program. It is also a possibility for the third party developers wishing 
to make additions to the program.

There are some plug-ins in the program distribution and You always can order or download 
for free more of them on the www.sqledit.com web site. All new extensions will be placed
there.

We can help You in distribution of your new useful plug-in. Contact us when You will have 
it written - we'll discuss a distribution policy: plugins@sqledit.com. 

How to build plug-in

Plug-Ins are common Win32 DLLs, placed in the same folder as the program and exporting 
at least two functions (see sample DEF-file in SDK):

 int WINAPI OnInstall(PL_DATA *data, ED_DATA *data2); 
 void WINAPI OnCall(); 

and two optional functions (see sample DEF-file in SDK):

 void WINAPI OnExit(); 
 void WINAPI OnSettings(); 

The first function gets called once when plug-in is initialized, the second - any time the 
plug-inï¿½s functionality is required, and the third - when plug-in is unloaded or the
program is stopped. OnSettings (if present) function called from "Settings" submenu of 
"Plug-ins" DTM SQL editor menu.

When something gone wrong during the plug-inï¿½s installation the OnInstall function
should return a nonzero result which is meant to be an error code. Current version of the 
editor doesnï¿½t do any special processing of the error codes. 

The data argument points to the structure filled with the plug-inï¿½s data, data2 points to
the memory location where the editor can store some info about itself.

The "OnInstall", "OnCall",  "OnExit" and "OnSettings" functions have to be extern "C".

Plug-in types

 PT_TEXT - Plug-In adds item for the EDITOR-page context menu.  
 PT_RESULTS - Plug-In adds item for the RESULTS-page context menu.  
 PT_MENU - adds item to main program menu after the last available item.  
 PT_SCHEMA - adds item for the SCHEMA-page context menu.  
 PT_PREPROCESSOR - plug-in called before any script execution  
 PT_AFTER_EXEC - plug-in runs automatically after any successful script execution.  

Warning!: This version of the editor assumes all pointers to be static and constant. Any
attempt to alter these pointers can lead to unpredictable results.

Warning! You can have only one PT_PREPROCESSOR plug-in installed simultaneously.

See also: "Data structures", "Simple plug-in"

 

http://www.sqledit.com/
mailto:plugins@sqledit.com?subject=help
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SDK Data Structures

ED_DATA structure description

1. iSize item contains size of the ED_DATA structure (sizeof(ED_DATA)). 
2. Version[3] array of three integer values contains version of DTM SQL editor. 1,0,9 

means 1.00.90 
3. DSN string contains name of the current "data source name". 
4. user string with user name who is currently logged in. 
5. owner contains name of the database schema currently selected. 
6. database contains name of the current database or empty string if not supported or 

not selected.
7. TEXT_PAGES - pointer of the function with one parameter returns number of editor 

tabs available and current active page 
8. RESULT_PAGES - pointer of the function with one parameter returns number of 

results tabs available and current active page 
9. GET_TEXT pointer of the function with three parameters: page number, pointer for 

text buffer, size of the buffer. This function provides extraction text from selected 
editor page. 

10. SET_TEXT pointer of the function with two parameters: page number, pointer for null-
terminated string with text. This function provides put text for selected editor page. 

11. GRID_SIZE pointer of the function with three parameters: results page number, 
pointers for X and Y dimensions. Function returns size of the grid for selected page. 

12. GET_CELL pointer of the function with five parameters: results page number, X and Y 
coordinates of the cell, pointer for text buffer, size of the buffer. This function returns 
value of the selected cell as a string.

13. password string with password of the user who is currently logged in. 
14. hMain - HWND of the main DTM SQL editor window  
15. db - reserved internal pointer. Please don't use or modify this structure item.  
16. SchemaItem - reserved internal pointer. Please don't use or modify this structure 

item.
17. interf - name of interface currently selected at "Connect" tab.  
18. prod - product code plug-in was called from. See DTM_PRODUCT enum for details.  

PL_DATA structure description

1. iSize item contains size of the PL_DATA structure (sizeof(PL_DATA)). 
2. type - type of the plug-in, see above.  
3. MenuItem - string (32 bytes or less) with name of the plug-in menu item.  
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Plug-in sample 

#include "plugin.h"

ED_DATA *ed_data;

const char sTitle[] = "Simple plugin";

/* --------  ON INSTALL function ---------------- */ 
int WINAPI OnInstall(PL_DATA *data, ED_DATA *data2)
{
ed_data = data2;
data ->type = PT_MENU; // plugin type 
lstrcpy(data ->MenuItem,"Test plugin"); 

MessageBox(0,"Install",sTitle,MB_OK|MB_ICONINFORMATION);
return 0;
}

/* -------- ON CALL function ------------------ */ 
void WINAPI OnCall()
{
char strBuf[1024];

sprintf(strBuf,"DTM SQL editor: %d.%02d.%02d\n"
"Interface=%s, DSN=%s, User=%s, Password =%s, Owner=%s,Database=%s\n"
"Editor pages=%d, Result pages=%d",

ed_data ->Version[0],  
ed_data ->Version[1],  
ed_data ->Version[2],  
ed_data ->interface,  
ed_data ->DSN, 
ed_data ->user,  
ed_data ->password,  
ed_data ->owner,  
ed_data ->database,  
ed_data ->txtp(),  
ed_data ->resp()  
);
MessageBox(0,strBuf,sTitle,MB_OK|MB_ICONINFORMATION);
}

/* -------- ON TERMINATE function (optional) --- */ 

void WINAPI OnExit()
{
MessageBox(0,"Exit",sTitle,MB_OK|MB_ICONSTOP);
}

/* -------- ON SETTINGS function (optional) --- */ 

void WINAPI OnSettings()
{
MessageBox(0,"plug -in settings",sTitle,MB_OK|MB_ICONSTOP); 
}
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Plug-ins Library. General information. 

This section contains the list of the available plug-ins for DTM SQL editor, grouped 
according to two criteria: the supported DBMS or the type. Thus, any of the available plug-
ins will fall under each of the hierarchies.

You can download some available plug-ins for free from SQL editor web site: 
http://www.sqledit.com/download.html

See also: "Plug-ins and SDK" 

© Copyright 1998-2018 DTM soft.
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Run Query Analyzer plugin

Information

This tool provides you run ISQLW from current DTM SQL editor environment with user 
name, password and database name currently selected. For return results of the edition in 
QA to SQL editor use save file. "ReadOnly" option in run_qa.ini must be "0" (default).

Installation

Copy run_qa.dll and run_qa.ini (if present) to DTM SQL editor directory for install this plug-
in.

Activation

To activate the plug-in click right mouse button at editor window and select "Query 
Analyzer" menu item.

Options

Revision History

 1.02 - support "Settings" dialog for SQL editor 1.60+.  
 1.01 - supports "DeleteTemp" option for temporary file deletion.  
 1.00 - original version with default features.  
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Run SQL*Plus plugin

Information

This tool provides you run SQL*Plus from current DTM SQL editor environment with user 
name and password currently selected.

Installation

Copy run_plus.dll and run_plus.ini (if present) to DTM SQL editor directory for install this 
plug-in. 

Activation

To activate the plug-in click right mouse button at editor window and select corresponding 
menu item.

Options

Settings/ReadOnly - don't save script for 1 values or save for 0 (default option).  

Settings/DeleteTemp - delete temporary files for 1 or not delete for 0 (default option) 

Settings/Options - additional options 

Settings/ConnectString - connect string, uses "database" for empty 

Path/WorkingDirectory - working directory. Plug-in uses %TEMP% for empty setting. 

Path/SqlPlus - Plus path, uses 'sqlplus' without path for empty setting.  

Revision History

 1.02 - supports "Settings" dialog for DTM SQL editor 1.60+.  
 1.01 - supports "Options" and "ConnectString" settings  
 1.00 - original version with default features.  
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Module Header plugin

Information

This plug-in provides you insert comment with identification information in your SQL 
scripts.

Installation

Copy ModuleHeader.dll to DTM SQL editor directory for install this plug-in. 

Activation

To activate the plug-in click right mouse button at editor window and select corresponding 
menu item.

Options

No options are available for this plug-in 

Revision History

1.00 - original version with default features. 
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Run external tool plugin

Information

Run External preprocessor.

Installation

Copy ext_prepr.dll and ext_prepr.ini to DTM SQL editor directory for install this plug-in. Edit
ext_prepr.ini for configure plug-in. 

Activation

This plug-in will be activated automatically. 

Options

Path/WorkingDirectory - working directory. Plug-in uses %TEMP% folder for empty setting. 

Path/CommandLine - command line. This option must be specified. You can use next 
parameters:

 %f means filename 
 %d means database
 %u means user name 
 %p means password 
 %o means owner 
 %N means Data Source Name 

Revision History

 1.00 - original version with default features.  
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Run external tool plugin

Information

This tool provides you run external program from current DTM SQL editor environment.

Installation

Copy run_it.dll and run_it.ini (if present) to DTM SQL editor directory for install this plug-in.
Edit run_it.ini for configure plug-in. 

Activation

To activate the plug-in click right mouse button at editor window and select corresponding 
menu item.

Options

Settings/ReadOnly - don't save script for 1 values or save for 0 (default option).  

Settings/DeleteTemp - delete temporary files for 1 or not delete for 0 (default option) 

Settings/MenuItem - text of the menu item. This option must be specified! 

Path/WorkingDirectory - working directory. Plug-in uses %TEMP% for empty setting. 

Path/CommandLine - command line. This option must be specified. You can use next 
parameters:

 %f means filename 
 %d means database
 %u means user name 
 %p means password 
 %o means owner 
 %N means Data Source Name 

Revision History

 1.05 - supports "Settings" dialog for DTM SQL editor 1.60+.  
 1.04 - supports "DeleteTemp" option for temporary file deletion.  
 1.03 - supports '%N' key for command line as current Data Source Name.  
 1.02 - extended command line parameters are supported. '%f' means filename with 

script, '%d' - database, '%u' means user name, '%p' means password, '%o' - owner.  
 1.01 - you can create copy of the plug-in DLL and INI with separated name for run few 

plug-in instances.  
 1.00 - original version with default features.  
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Run external tool after execution plugin

Information

This tool provides you run external program when script executed successfully.

Installation

Copy run_ae.dll and run_ae.ini to DTM SQL editor directory for install this plug-in. Edit
run_ae.ini for configure plug-in. 

Activation

This plug-in will be activated automatically. 

Options

Path/WorkingDirectory - working directory. Plug-in uses %TEMP% for empty setting. 

Path/CommandLine - command line. This option must be specified. You can use next 
parameters:

 %f means filename 
 %d means database
 %u means user name 
 %p means password 
 %o means owner 
 %N means Data Source Name 

Revision History

 1.00 - original version with default features.  
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Save and Load History plug-ins 

Information

This tool provides you save and load file and execution history of the DTM SQL editor.

Installation

Copy SaveHist.dll and LoadHist.dll to DTM SQL editor directory for install this plug-in. 

Activation

To activate the plug-in select corresponding menu item in PlugIns submenu. 

Options

No options are available for this plug-in. 

Revision History

 1.00 - original version with default features.  

© Copyright 1998-2018 DTM soft.



Send Script by e-mail plugin 

Information

This tool provides you send SQL script from current DTM SQL editor by e-mail. 

Installation

Copy SendScript.dll to DTM SQL editor directory for install this plug-in. 

Activation

To activate the plug-in click right mouse button at editor window and select corresponding 
menu item.

Options

No options are available for this plug-in 

Revision History

 1.00 - original version with default features.  
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Simply C-like preprocessor plug-in  

Information

Simply C-like preprocessor. Supports only #define, #undef, #ifdef, #else and #endif 
statements.

Installation

Copy s_prepr.dll and s_prepr.ini to DTM SQL editor directory for install this plug-in. 

Activation

This plug-in will be activated automatically. 

Options

Options/WithPreview - show or hide preview dialog with preprocessor results. 

Revision History

 1.01 - supports "WithPreview" option and preview dialog.  
 1.00 - original version with default features.  
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Run WinDiff plugin

Information

This plug-in provides you compare two text scripts using external compare tool, WinDiff for 
default setting.

Installation

Copy ToWinDiff.dll and ToWinDiff.ini (if present) to DTM SQL editor directory for install 
this plug-in. 

Activation

To activate plug-in select corresponding menu item in PlugIns submenu. 

Options

Settings/Options - specify additional compare tool options like -O, -P etc. 
Path/WorkingDirectory - working directory, plug-in uses %TEMP% for empty setting 
Path/ExePath - tool path, uses WinDiff without path for empty setting. 

Revision History

 1.02 - supports "Settings" dialog (SQL editor 1.60+ required).  
 1.01 - "Options" key in [Settings] section of the INI file supported for additional 

WinDiff options. 
 1.00 - original version with default features.  

 



 

  

  

     
    

   

�   
�  

�   

© Copyright 1998-2018 DTM soft.



Database utilities by DTM soft

DTM SQL Editor (www.sqledit.com/editor) is a set of powerful database management tools 
that allow you to achieve two goals - to have unified access to different types of
databases and to have a set of solutions that makes processing your data easy. DTM SQL 
Editor gives database users, developers and administrators an ability to access different 
databases, whether desktop or client-server ones (provided you have ODBC driver 
installed). This is very convenient, since most organizations use several different types of
databases installed and each stores data in different formats and with varying parameters. 
Having a program that can get data from various sources is often essential. Furthermore, in 
addition to letting you quickly switch between different data sources, DTM SQL Editor lets 
you see database schema and results of the query execution.

DTM Migration Kit (www.sqledit.com/mk) is a powerful yet simple data migration tool that 
comes in handy if you run multiple databases. Use it to import, export or migrate data 
between different data sources (ODBC, OLE DB, or Oracle Call Interface supported). The 
program is fully automatic and supports all popular database formats. Simple visual 
interface lets you set own transformation and flow control rules to give you added 
flexibility.

DTM Schema Reporter (www.sqledit.com/sr) is a reporting tool for database schema. The 
program creates reports in RTF, HTML, XML or plain text formats and supports all common 
database interfaces - ODBC, OLE DB, or even Oracle Call Interface. This utility helps 
technical writers and database administrators create a report of any complexity level within 
seconds. Also, you can alter table order in the report and manually add annotations to the 
individual tables.

DTM Data Generator (www.sqledit.com/dg) is a simple, powerful and fully customizable 
utility that generates data for database testing purposes. Currently, database developers
and administrators often have to spend hours of dull work to create test data sets before 
examining database performance. This tool makes all this unnecessary by automatically 
creating database objects AND sets of SQL statements, if necessary.

DTM Data Editor (www.sqledit.com/de) is a data viewer and editor for database 
professionals who are tired of wasting their time on mundane tasks. The program uses 
form-based interface and works with any ODBC data source. SQL statements are generated 
automatically and can by modified later. For data that has foreign key - primary key 
relation, there are options to enter values manually or select them from a list, which is 
much faster.

DTM DB Stress (www.sqledit.com/stress) is a utility for stress testing the server parts of
information systems and applications, as well as DBMSs and servers themselves. This tool 
allows you to create and configure a continuous set of requests to the server of the OLAP 
(query execution) and OLTP (adding, modifying and deleting data in the database) types. 
At the same time, the user can flexibly change both the number and the priority of this or 
that type of requests to a database or an application.

DTM Data Modeler (www.sqledit.com/dm) is a CASE tool for database developers that 
supports both forward and reverse engineering. It is an easy-to-use tool allowing you to
work both with logical and physical data models in the form of an entity-relationship
diagram. The product is intended for database architects and developers and works with 
data sources via the ODBC interface, which means compatibility with all modern DBMS. 
Along with basic model properties (sets of entities and relationships between them), the
program allows you to create indexes and triggers on the physical level corresponding to 
the tables of the database that is modeled.

DTM Data Scrubber (www.sqledit.com/scr) is a set of intelligent tools for data verification
(audit) and scrubbing (cleaning). Depending on user-defined rules and data properties, the 
program either creates a report about the actual state of affairs or performs database data 
correction. 

 

 

http://www.sqledit.com/editor
http://www.sqledit.com/mk
http://www.sqledit.com/sr
http://www.sqledit.com/dg
http://www.sqledit.com/de
http://www.sqledit.com/stress
http://www.sqledit.com/dm
http://www.sqledit.com/scr
http://www.sqledit.com/dcmp
http://www.sqledit.com/scmp
http://www.sqledit.com/qr


 

 

 

 
 

  
 

 

DTM Data Comparer (www.sqledit.com/dcmp) is a visual tool for data compare and 
synchronization. The program successively views the contents of both tables basing on the 
order of ascending of unique key values and shows differences or creates synchronization 
script. 

DTM Schema Comparer (www.sqledit.com/scmp) is a tool for database schemas comparison 
and synchronization. The comparison process supports tables, views, indexes, triggers and 
stored procedures. The visual representation of database schemas as a tree makes the 
comparison process more comfortable. 

DTM Query Reporter (www.sqledit.com/qr) is a reporting tool for database query. This 
utility helps technical writers, developers and database administrators create a report 
based on database query within seconds. 

DTM Schema Inspector (www.sqledit.com/si) is a database schema browsing and 
management tool that let you work with database schemas more effectively. 

DTM DB Event (www.sqledit.com/event) is a database monitoring and management tool. 
This utility allows the user to define a few situations (events). For each event the user can
define what the program should do if the event is occur. 

DTM Flat File Generator. Easy to use tool that helps any developer or QA engineer to create 
test data file. It supports tab-delimited, CSV, fixed width and custom separated output 
files. The generator has powerful import and export file structure features. 

DTM Test XML Generator. The tool is powerful generator for XML documents with structure 
defined by user and random but realistic data. More than 30 predefined generators with 
powerful pattern engine. The rich import XML structure options are available. 

DTM Data Generator for Excel is a tool for text Excel spreadsheet population. Easy to use
interface based on predefined generators, rich value library and high performance. 

DTM Data Generator for JSON produces JSON files with defined structure in a bulk manner. 
Fast and easy structure editor and smart import options helps the user to generate test set 
in a few clicks only. 

DTM Database Content Analyzer is a statistical tool for database content. It collects a few
dozens of most interesting data: database objects size, value frequency, clusters, etc. This
tool replaces and extends "Statistics" report of obsolete versions DTM Schema Reporter. 

 

http://www.sqledit.com/si
http://www.sqledit.com/event
http://www.sqledit.com/filegenerator
http://www.sqledit.com/xmlgenerator
http://www.sqledit.com/excelgenerator
http://www.sqledit.com/jsongenerator
http://www.sqledit.com/DatabaseAnalyzer
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Demo and Full versions

What differences between the demo and full versions of DTM SQL editor?

General functions

 Demo version replaces some data grid values to DEMO string starting 6th row. 
 Demo version has blocked Save SQL script feature for scripts longer that 100 symbols. 

Supplemental functions

 Data Model (Entity-Relationship) viewer partially replaces column names to DEMO 
string. 

No other demo limitations are present except nag-screen at program shutdown. 
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Program Installation

To run installation program:

 Open the windows Start menu and select "Run" item 
 Select or enter installation file name and path (editor.exe or editor_d.exe)* and click 

OK 

* - professional and enterprise editions of the tool may have another suffix.
 

Notes:

 Please be sure that existing version of the tool is not running when you install a new
version. 

 We recommend to uninstalling old version of the DTM SQL editor before new version 
installation.

 Installation by administrator for another user is supported for most environments. 
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How to upgrade your copy of DTM SQL editor?

The user can refer to "Check for Update" features to get information about available 
updates.
Please contact our support staff at support@sqledit.com to upgrade commercial version of 
the tool.

Demo version is available for download free of charge.

When you upgrade your copy of DTM SQL editor please send us the following information:

 You name, company name and how to contact you 
 Payment information (at least "ORDER No" and "Date") 

© Copyright 1998-2018 DTM soft.

mailto:support@sqledit.com?subject=DTM SQL editor
http://www.sqledit.com/editor/download.html


Uninstall the Software

The Uninstall feature removes all installed DTM SQL editor components and all records in 
the Windows registry made by the installation script. You can uninstall this program by 
selecting the "DTM SQL editor" item in "Add/Remove Programs Dialog" in "Control 
Panel".

Another uninstallation way is to run "unins000.exe" from the product's folder directly.

Important! Uninstall feature of the program does not remove files and objects created by 
users such as configuration files, registry records etc.
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How can I order DTM SQL editor software?

The software is available worldwide via the Internet. Secure online, mail/check and 
corporate purchase order options are available. For detailed information please click 
following link to open order page or copy http://www.sqledit.com/editor/order.html to your 
web browser. 

If you have any payment questions feel free to contact the DTM SQL editor technical 
support at support@sqledit.com
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License Agreement (EULA)

This License Agreement covers all existing versions of DTM SQL editor (Software) and 
technical support service (Service). This License Agreement is a legal agreement between 
the end-user (Licensee) and DTM soft (Licensor). 

CAREFULLY READ THE TERMS AND CONDITIONS OF THIS AGREEMENT PRIOR TO USING 
THIS PRODUCT. USE OF ANY PORTION OF THIS PACKAGE INDICATES YOUR AGREEMENT TO 
THE FOLLOWING TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH SUCH TERMS AND 
CONDITIONS, DO NOT INSTALL THE SOFTWARE.

General Information

1. Licensor is exclusive owner of all DTM SQL editor copyrights. DTM SQL editor is 
protected by copyright laws and international copyright treaties. 

2. Demo version. Anyone may install and use demo version of DTM SQL editor for 
evaluation and testing purposes free of charge. 

3. The product is licensed, not sold. I.e. Licensor grants to Licensee non-exclusive, 
perpetual, royalty-free right and license to install, configure, execute and otherwise 
productively use a copy of the Software for the commercial or non-commercial 
purposes, including internal business purposes. Licensee may install and use each 
licensed copy of the Software on a single computer. The primary user of the computer 
on which DTM SQL editor is installed may make a second copy for his or her exclusive 
use on a portable computer. 

4. Licensee may not reverse engineer, modify, translate, decompile, or disassemble DTM 
SQL editor. The Software is licensed as a single product. Its component parts may not 
be separated for use on more than one computer. 

5. Licensee may not rent, lease, or lend the Software. Also, Licensee may not resell, or 
otherwise transfer for value, the Software. 

6. Without prejudice to any other rights, Licensor may terminate this License Agreement 
if Licensee fail to comply with the terms and conditions of this Agreement. In such 
event, Licensee must destroy all copies of the Software with all of its component
parts. 

7. Licensee may permanently transfer all of rights under this license, provided Licensee 
retain no copies, Licensee transfer all of DTM SQL editor (including all component 
parts), and the recipient agrees to the terms of this license.

8. DTM SQL editor IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED 
OR IMPLIED. LICENSEE USE DTM SQL editor AT YOUR OWN RISK. IN NO EVENT SHALL 
EITHER PARTY BE LIABLE FOR DATA LOSS, DAMAGES, LOSS OF PROFITS OR ANY 
OTHER KIND OF LOSS WHILE USING OR MISUSING THIS SOFTWARE. 

Delivery

Licensor delivers the Software electronically over Internet. The delivery includes 
installation/activation key, software, documentation* and additional materials with
installation program*. Licensor confirms that the delivery contains no illicit code or third 
party code.
The customers in North America allowed to request physical delivery on CD for extra fee.

*- the multiplatform edition of the software (if applicable) has online documentation only 
and requires no installation program.

Licensee Data

Licensor understands and acknowledges that Licensee may manage, modify, summarize, 
maintain, create derivative works of, and update pre-existing data and information, and 
generate, manage, modify, summarize, maintain, create derivative works of, and update 
additional data and information using the Software. Licensor acknowledges and agrees that 
all rights in any work product created by Licensee shall be solely owned by Licensee. 
Licensor has no access to mentioned work product without grant by Licensee. Moreover, 

 

 



  

 
 

 

 

 

  

 

Licensor shall not seek access to Licensee personal data.

Functionality

Licensor may remove or change any supplemental or non critical functionality of the 
Software without any notifications. Licensor may change product documentation and project 
file format. If Licensor deletes any key feature or functionality from the Software equal 
solution should be provided to Licensee without additional fee.

Third Party Software and Intellectual Property

Licensor hereby confirms that the Software contains no third party components including 
Open Source code.

Support and Upgrades

During one year after ordering any license of the Software except "Site" and "World" 
licenses, Licensee are entitled to free technical services and support for DTM SQL editor 
which is provided by Licensor. During this period, e-mail support is unlimited and includes 
technical and support questions. Also, during one year, Licensee may access to free 
updates to DTM SQL editor when and as DTM soft publishes them on www.sqledit.com. 
After end of the described period Licensee may continue to use the software product in 
accordance with the terms of this Agreement except free support and upgrades. After end 
of the free support and updates period (one year), Licensee may purchase annual Upgrade 
and Support subscription. If Licensee has a few licenses, Licensee will access to free
upgrade and support period and will use subscriptions independently.

There are two support service levels: Standard and Premium. By default, the Software 
includes Standard level of the Service. The Premium should be ordered separately. The 
Premium service offers reduced response time and high priority for support requests. The 
technical support response time for Standard level is between 2 and 12 hours except Jun, 
July and August with 2 to 24 hours range. It is available 5 days per week (Monday to 
Friday). For the Premium level it is 2 to 6 hours 7 days per week.

Export Compliance

Licensor hereby confirms that the Software requires no export controls at a level other than 
EAR99/AT.

Price Protection

Licensee who purchases volume license of the Software allowed to order additional copies 
with the same price during following period after initial deal: 3 months for 3 to 5 copies, 6 
months for 6 to 10 copies and 9 months for 11 or more copies.

Trademarks information

DTM SQL editor is trademark of DTM soft.

Licensee hereby grants DTM soft a right to use company name or trade names solely in 
connection with the rights granted to DTM soft pursuant to marketing materials and web 
site. If this clause breaches company policy DTM soft is happy to remove it upon request.

 



  

 
 

 

 

 

  

 

 

© Copyright 1998-2018 DTM soft.



Technical support

If you have some question or unusual problem feel free to contact the DTM SQL editor 
technical support at support@sqledit.com 

When you contact technical support, you should be prepared to provide the following 
information: 

 DTM SQL editor version (you can find this information from About menu item of Help 
menu). 

 Type and version of the ODBC or IDAPI driver or OLE DB provider. 
 DBMS version and operating system version (including service pack version, if 

applicable). 
 DTM SQL editor Log file. 
 A description of what you do before the problem occurs. 
 Error messages you see when the problem occurs. 
 Your name, company name and how to contact you. 

See Also: log file
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Feedback form

You opinion about our products is very important for us. Please fill this form and press 
send button. It will be send using your default mail client.

DBMS you are using:

Most useful features of DTM SQL editor:

Your rating of product features and components

 

MS SQL Server SYBASE Oracle

DB2 Interbase Informix

MS Access MySQL/mSQL Other

script editor

schema viewer

results page

export tools

SQL builder

Stability ..select value.. enter your comment here

Usability ..select value..

Performance ..select value..

  
Script editor ..select value..

Schema 
viewer

..select value..

Results
page

..select value..

Export tools ..select value..

SQL builder ..select value..

SEND CLEAR
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Product FAQ, program tips

Frequently Asked Questions

Q: How can I use DTM SQL editor as the external editor for Oracle SQL*Plus ?

A: There are two options: permanent use and single session use. If you choose the 
permanent use mode, you should create or edit login.sql file in the home directory of 
SQL*Plus (D:\ORANT\BIN) and insert the following line: DEFINE _EDITOR=<program 
path>, see below for reference.

WARNING: in the case when the path has spaces, put it into quotation marks; see the
second figure.

If you choose the single session use mode, just type

DEFINE _EDITOR=<program path>, for example:  
DEFINE_EDITOR=C:\Program Files\SQLedit.exe

Another way is to select Editor/Define Editor item in "Edit" menu and to type the program 
path in the dialog box.

Q: What is the easiest way to place query results into MS Excel spreadsheet format?

A: Right click over the page with the results and select "Export". Select "Excel" as your 
export format.

Q: Are there easy ways to publish the results on the Web?

A: Use HTML export feature. Right click over the page with the results and select "Export". 
The program saves data in the very basic format, so we recommend you to employ some 
more powerful HTML authoring tool to edit the data afterwards.

Q: I usually acquire data from several data sources at a time. How could I know which 

 

 

 

 



 

 

 

 

 
data source I'm connected to?

A: Starting from the version 1.00.84, the program displays the name of the current data 
source you are connected to, user name and the name of the data scheme in the window 
title in "DSN/user/owner/database" format. If some of these fields are empty, they are not 
displayed, but separating '/'s remain.

Tips. Did you know...

You can get quick access to the file or script you edited earlier by using drop-down menues 
near Load and Run toolbar buttons.

You can use macros to automate entering scenarios.

You can use right mouse button to get access to the context menu in SQL editor or results 
viewer.

You can select rows, columns or set of cells in the results grid using left mouse button and
drag.

You can view Binary Large Objects as binary or as hexadecimal. View "Settings" for more 
details...

Program can visualize NULL data values as empty strings or as "NULL" strings. See program 
options for detailed information...

You can view current cursor position at the right side of the DTM SQL editor status bar.

Program always creates backup (.BAK) file in the same directory to avoid data overwriting.

Program always creates "auto-save" file for the current script before running it to prevent 
data loss.
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Tutorial

How do I save script?

Just select "Script->Save" item in the menu of the main program window. You will be 
asked to enter the name of the file if the file being edited was created with the "New file"
command.

Execute "Script->Save as" command when you want to save the file with a different name. 
The dialog that follows will allow you to change the directory and specify the name for the 
current file. Pay your attention to the preview capability of this dialog, so you don't 
overwrite necessary file(s) or script(s).

Every time you make any changes in the file and decide to exit the program, you will be 
warned and asked about saving this file with several options provided.

If auto save feature has been enabled, the program periodically will save the contents of 
the current file into "autosave.tmp" that can be found in the program's directory (for ex. 
C:\Program Files\SQLedit\autosave.tmp).

How do I load existing script?

When running the program, you have to select "Script->Load" menu item in the main 
window to load the script file. "Open File" dialog allows you to preview SQL script before 
the file is loaded into the editor.

Specifying the filename as an argument in the command line. For example: se.exe 
MySQLscript.sql

Using drag-n-drop. If you have the program running, simply grab the file and drop it 
anywhere inside the main window. Otherwise, drop it onto the program's shortcut icon 
(located on the Desktop or in the folder you placed it in) - and the program will start with 
the file loaded into the editor.

Using Edit history. "Load" toolbar button has the special drop-down menu, which lists the 
files you have edited last time. Selecting the file from the menu and it will be loaded
again.

How do I get and view the results of script execution?

If the SQL script being executed produces the resulting recordset, you can view it in the 
"Results" pane of the main window. It allows you to:

 list the record set one record by one or page by page; 
 set the width of columns representing the fields of records; 
 see the current record number. 

Placing the mouse cursor over the column header will tell you the type of data stored in 
this field.

How to select a database to connect to?

Please use "plus" toolbar button or Connect menu item for open "Connect" dialog to select 
Interface (ODBC, IDAPI or OCI), Data source or alias name, user name and owner name.

Some types of DBMS require user name (login) and access password to be specified. When 
you want to access the tables belonging to one data scheme (or owner), you should fill the 
"owner" entry, otherwise all tables will be accessed.

Important! Database name selection support works only for Microsoft SQL Server 6.5 or 
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Troubleshooting Guide

Troubleshooting guide

Q: I cannot run the program and there is no error message. What should I do?

A: Check if you have all required files installed. Try to reinstall the program.

Q: When I ran the program, it displays "Can't open SQL file" error message . What 
does it mean?

A: Most probably, the file you have edited the last doesn't exist or has been renamed. See 
the title of the message dialog for the name of the file being missed.

Q: The program incorrectly informs me about two or three void choices when dealing 
with the complex SQL statement.

A: This is because the program cannot recognize some SQL dialects. To solve the problem, 
turn the option "Disable SQL parsing" ("Settings" dialog) on. 
Important! The program is unable to operate correctly with the scripts containing multiple 
queries when parsing is disabled.

Q: I have changed the resolution of my display and can't find the program. Where is 
the program now?

A: You should locate "HKEY_CURRENT_USER\Software\DTMsoft\SQLeditor2" registry entry 
and remove "MainWindow" key. The main window will have the default dimensions.

Q: The program detected the installed OCI, but displays an empty list of data sources. 
What should I do?

A: Perhaps, the file tnsnames.ora was not found. Either put that file in one of the folders
given below or contact the technical support:
%ORACLE_HOME%\net80\admin\tnsnames.ora or
%ORACLE_HOME%\network\admin\tnsnames.ora

If you have encountered some unusual problem that is not listed here, feel free to contact 
our technical support.
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Glossary

Database catalog - The collection of system tables, tables that store metadata about that
specific database.

Database record - one row in a table (table can be a result of SQL-query). 

Database schema - logically connected, usually owner-based, set of DBMS objects (tables,
views, procedures etc).

DBMS - database management system. 

DBMS connection - the fact that both client and DBMS server have signed a contract and 
ready to query and data communications.

Drag-n-drop - the file manipulation technique when the mouse is used to move the file
from the place of storage to the program, which performs processing.

SQL language - the declarative language used to manipulate the data and its' structure in 
the modern DBMS and their client applications.

IDAPI - Integrated Database Application Program Interface, unified DBMS access interface. 

OCI - Oracle Call Interface, access interface for Oracle Server. 

ODBC - Open Database Connectivity, unified DBMS access interface. 

Metadata - information about data. See also: database schema 

SQL statement - single SQL operator having the complete role in a data manipulation 
script.

SQL-server - program or program complex, which is able to execute the SQL-queries. 
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SQL Quick Reference

 SELECT 
 CREATE TABLE 
 INSERT 
 DELETE 
 UPDATE 
 DROP 
 GRANT 
 REVOKE 

Syntax Notation 

 [] - optional construction  
 {} - repeatable construction  
 INSERT - keywords  

Syntax definition Example

SELECT [predicate]
{ * |table.* | [table.]field_1 [AS alias_2] [, [table.]
field_2 [AS alias_2] [, ...]]}
FROM statement [, ...]
[WHERE... ]
[GROUP BY... ]
[HAVING... ]
[ORDER BY... ] 

select A as "Value", B as "Sum"
from MyTable
where A>B and A>0
order by B

INSERT syntax for add one record:
INSERT INTO table [(field_1[, field_2[, ...]])]
VALUES (value_1[, value_2[, ...])

Syntax for subquery based INSERT:
INSERT INTO table [(field_1[, field_2[, ...]])]
SELECT [source.]field_1[, field_2[, ...] FROM-
expression

insert into MyTable (A,B) 
values (5,80)

DELETE [table.*]
FROM table
WHERE selection_condition

delete from MyTable 
where A>470

UPDATE table
SET { field = expression_for_new_value }
[WHERE selection_condition]

update MyTable
set A=40
where A<25

DROP <object type> <object name>

Object types: table, view, index, etc.
drop table MyTable

CREATE TABLE <table name>
( field_description,... [CONSTRAINT <constraint>])
<field description> ::= <field name> <field type>
<constraint> ::= <constraint_name> PRIMARY KEY 
(<fields name list>)

create table MyTable
( A integer,
  B decimal
)

GRANT statement[,...]
TO account[,...]
or
GRANT permission[,...]
ON object[,...]
TO account[,...]

GRANT DROP DATABASE, CREATE 
TABLE
TO Mary, Peter

GRANT INSERT, UPDATE, DELETE
ON Rating
TO Tom

REVOKE statement[,...]
FROM account[,...]

REVOKE CREATE TABLE 
FROM Mary
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or
REVOKE permission[,...]
ON object[,...]
FROM account[,...]

REVOKE INSERT
ON Rating
FROM Tom
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Log File

Log file

When running the program, you have to select one of menu items from "Tools->Log file" in 
order to view or truncate your Log file. The log file contains the detailed description of any 
errors and other events that occurred while processing script. 

Default log file location is product's directory and the name is ERROR.LOG. When the user 
has no enough permissions DTM SQL editor saves log to typical path like C:\Documents 
and Settings\<username>\Application Data\editor.log or 
C:\Users\<username>\AppData\Roaming\editor.log

The log file is a text file that contains three type of records:

1. The software product identification block: product name version and operating system 
information. 

2. Error records: wrong SQL statements, exceptions, etc. 
3. Notification and statistics.
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